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Sign Wizard 6.5 and Neon Wizard 6.5
Upgrade Guide
The purpose of this document is to introduce you to the new
features, capabilities, and improvements in Sign Wizard 6.5 and
Neon Wizard 6.5. As a current user, you want to know what is
new in the software and how it works so that you can decide
whether to purchase the upgrade. Read this document carefully
and you’ll be up to speed on the new features and program
improvements.
This upgrade guide describes the New Features and the Improved
Features in version 6.5. You can read any or all of the items; each
is separate and independent. The programs – Sign Wizard and
Neon Wizard - and the levels for each of the new and improved
features is included in the descriptions.
We are assuming that you are an experienced user of the
software as we describe the new capabilities. If you don’t
understand some of the descriptions in this guide, please go to
the On-line Help menu in the program for a more complete
explanation of all the features and capabilities.
As always, please feel free to contact us directly by phone or
email, or visit our Web site at www.aries-graphics.com.
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Importing and Exporting PDF Files
Sign Wizard and Neon Wizard – all levels
All levels of Sign Wizard 6.5 and Neon Wizard 6.5 can now import
and export PDF files. PDF is rapidly becoming the method of
choice for professional graphic designers to transfer vector and
raster files between graphic design programs. There are two new
import filters in Sign Wizard 6.5:
(1) Interpreted Postscript (*.EPS, *.AI, *.PDF)
(2) Rasterized Postscript (*.EPS, *.AI, *.PDF).
If you want to import an EPS, AI or PDF file and retain all the
vector data (the file may also contain raster data), use the
Interpreted Postscript import filter. If you want to convert any
vector data to raster data, use the Rasterized Postscript import
filter.
Until recently, importing and exporting between the various
graphic design programs has been very problematic for everyone
in the graphic design industry. This is rapidly changing with the
broad acceptance of the Adobe PDF format because PDF files are
usually precise and highly compressed with a minimal loss of
precision. This means that even for very complex designs a
PDF files will usually be small enough to send by e-mail.
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High Quality Anti-aliased Rendering
Sign Wizard Advantage, Grand, Pro - Neon Wizard all levels
Vector graphics can now be displayed in Sign Wizard 6.5 using
anti-aliasing as shown below. Anti-aliasing gives a very
smooth look that will give your designs a more
professional appearance.
When you create a raster image in Sign Wizard 6.5, be
sure to have the Anti-aliasing feature turned on to get the
best quality raster image. Of course the pixel count (width and
height) in the Export dialog box are also very important in creating
a sharp raster image.
In earlier versions of Sign
Wizard, vector images may
appear chunky (especially if
the resolution of your monitor
is not very high) as shown
here on the left, rather than
very smooth, as shown on the
right. To get the smooth look,
set the Drawing Mode in the
View menu to the High
Quality Anti-Aliased mode.
For complex designs with lots of vector data, the anti-aliased
mode may not be displayed as fast as the Standard drawing
mode, so you have the option to run the program in either the
Standard mode or the High Quality Anti-Aliased mode. Since
it is usually not as important to have smooth vectors when colors
are turned off, it is recommended that you check the option to
Use Standard when Show Fill Colors is off.
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Adobe Type 1 and Open Type fonts.
Sign Wizard Advantage, Grand, Pro - Neon Wizard all levels
In addition to the wide variety of fonts supplied with all levels of
Sign Wizard and the True Type fonts available on your computer,
you can now import Adobe Type 1 and Open Type fonts. This
will give you many more high quality fonts to choose from.
If you have an Adobe Type 1 or an Open Type font file, click on
Import Font from File in the Text menu and browse until you
find the file containing the data for the new font. Click on Import
in the Import Font File dialog box.
The complete font will appear showing all the characters. You can
change the name of the font or do any editing that may be
needed. The imported font is converted to a Sign Wizard font and
will be available to use in the same way the standard Sign Wizard
fonts are used.
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Anchor Points
Sign Wizard and Neon Wizard – all levels
This new tool is very handy for making precise numeric
placements of design elements. You can now specify which of
the nine Handles you want to use as the reference point for the
X and Y position values. When you select any object, the
Handles are the small boxes at the corners, in the middle of the
four sides and the geometric center of the object.
For example, if you want to position the center of Text 1 which is
4” tall X 8.5” wide at X = 5” and Y = 9”, click on the box in the
center of the nine boxes (which will then turn black), enter the
coordinates (5 and 9 as shown on the left) and the geometric
center of Text 1 will be positioned exactly at that spot.
If you want Text 2 with a width of 3” and a height of 0.75” to
have its lower left corner at X = 7 and Y = 13, you would select
the object, click on the small square in the lower left corner and
enter the X and Y coordinates (7 and 13 as shown on the right).
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Vertical Weed Lines in Plot Manager
Sign Wizard Advantage, Grand, Pro – Neon Wizard all levels
In addition to the horizontal weed lines introduced in Sign Wizard
5, version 6.5 introduces vertical weed lines to further reduce the
risk of having to do re-cuts. By having weed lines in both the
horizontal and vertical directions, weeding the most
intricate designs could not be easier.
The example below may be a little over the top, but the weed
lines are created manually, so you can put in as many weed lines
as you need for each design. If a design is very simple, you may
not need any weed lines at all.
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Interactive Bitmap Rotate Tool
Sign Wizard Advantage, Grand, Pro - Neon Wizard all levels
This feature is very handy for rotating an image that is slightly
skewed. Just click on the bitmap rotate tool

drag a line from left to right to define the new level

and then click on Done.
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Expanded Send to RIP Features
Sign Wizard Advantage, Grand and Pro
When outputting to an Onyx RIP, Sign Wizard 6.5 now includes
the PDF format, preview, rotation and cropping options. You can
also specify the number of copies you want. These new features
will streamline your workflow.
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Neon Preview now works on Groups
Neon Wizard Pro
Formerly the Neon Preview feature worked on one neon object at
a time - limiting the number of colors to just one. Now Neon
Preview works on a group of tubes containing many different
colors.
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LED Wizard Module
Neon Wizard Pro, Sign Wizard Pro (w/Neon Pro feature set)
This optional module allows you to create precision LED channel
letter layouts in a fraction of the time it takes trying to adapt other
graphic design software to the task. In addition, the number of
LED modules required, the power requirements for each character
and the totals for the complete job are automatically tabulated
and sent to Excel to create a spread sheet to insure accurate
quotations and lists of materials for production.
The detail specifications for most of the leading LED suppliers
offering LEDs for use in channel letters are now available in LED
Wizard. Work is continuing to incorporate the specifications for
additional LED suppliers.
Sample LED layouts
The following examples illustrate how LED Wizard works. The text
below is 18” tall Helvetica Medium with a 3½” stroke width, so a
single row of LED modules is needed.

Click on the LED menu and select the brand and model LED to be
used. In this example, a fictitious brand and model were selected –
ABC Red - from the list of available modules. Enter 1 in the box
labeled Runs. The other boxes (Separate Letters, Auto Spacing
and Auto Stroke Count are left unchecked.)
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When you click on Done the LEDs will automatically be positioned
in the center of the letter strokes as shown below.

In the next example the Bookman Bold text is 40” tall with a stroke
width that varies from 6” to 15”, so the number of LED stokes will
vary with the stroke width of the letters.

In this example the Clearance is set for 1.5” with 4 Runs and the
Run Gap is set at 2.5”. For this example the other options are left
unchecked.
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The resulting layout of the LEDs is shown below.

When the LEDs are positioned in the channel letters, as shown
above, the data on the number of modules and the power
requirements is automatically sent to Excel which generates the
spreadsheet summary shown below.

LED Wizard Template
Brand

LED
Module

Letter

Modules /
Run

ABC

White Mini

ABC

White Mini

ABC

White Mini

ABC
ABC

White Mini
White Mini

ABC

White Mini

42

ABC

White Mini

20

ABC

White Mini

D

TOTAL

Modules

Modules
/ Letter

48
L

19
18
24

18
262

Watts /
Letter

28.80
67

73
E

Watts /
Run

11.40

40.2

43.80
91

10.80
14.40

54.6

25.20
12.00
104

10.80

62.4

Watts

157.2

The Excel spreadsheet can be expanded as needed to include all
the costs for generating complete quotations and for production
control. For example, the total number of LED modules and the
total number of power supplies can be multiplied by their unit costs
and included along with the other production costs (to produce the
channel letters with their plastic faces, installation, etc.) to arrive at
the total cost for the job. It should be noted that prices for the LED
modules or power supplies are not included in the data generated
by LED Wizard.
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LED layout options
There are three check boxes that were left unchecked in the LED
Wizard examples illustrated above: Separate Letters, Auto
Spacing and Auto Tube count.
If Separate Letters is checked, each letter outline and the LEDs
inside each letter will be individually selectable. If Separate
Letters is not checked, all the letter outlines will be a single
graphic object and all the LEDs inside the letters will be a separate
graphic object.
If Auto Spacing is checked, there will be two rows of LED
modules. This feature is intended for use with fonts whose stroke
width ratio is about 1.5:1. Where the stroke width of the letter is
thin, the Clearance value you enter sets the minimum spacing
between the edge of the letter and the edge of the LED module.
In the areas where the stroke width of the letter is thicker, the
centers of the LED strokes will be 25% from the edge of the
letter.

If Auto Tube Count is checked, the number of strokes will be
determined automatically using the Clearance and Stroke Gap
values you entered to position the LEDs as shown below.
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Manual Editing for LED layouts
There are cases where the automatic LED positioning features
may not result in the best layouts. Manual editing tools are
available in LED Wizard that allow you to reposition, add or delete
individual LED modules. These cases are more likely to occur with
designs that have thin serifs, connecting script characters,
complex logo shapes, “high stroke width ratio” fonts or otherwise
deviate from simple block letters that have relatively uniform
stroke widths. The manual editing tools for LEDs are similar to
those used for editing neon tubes and the vectors that define the
outlines for letters and logos. The LED Editor tool is a flyout
(shared with the Neon Editing tool) in the fourth position from the
top in the Toolbox on the left side of the screen. The LED Editor
Tool looks like this:
The examples below illustrate how the LED Editor tool can be
used to handle the kinds of situations indicated above. For details
on using the LED Editor go to the Help menu and search on
LED Property Bar.
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Rasterize Tool
Sign Wizard Pro
You can save hours of design time using this handy new
tool in the Image menu which converts vector images into
raster images without going through the usual steps of exporting
and importing. You have the option of saving the original vector
image or discarding it. This tool makes it easier to produce a
large number of copies of the same complex design.
Using the Rasterize feature together with the Crop tool you can
modify raster images to better fit the available space in your
designs. You can also add Transparency to the raster images.
When the colors are turned on, it may not be apparent if an object
is a vector image or a raster image. Colors are turned on and off
by pressing the F3 key. For a raster image, when the colors are
turned off, only the boundaries will be displayed as a thin blue
line. When the colors are turned on, all the details of the raster
image will be visible. For vector images, when the colors are
turned off, the details of the object are shown in thin blue lines
(outer loops) and red lines (inner loops), but the fill colors are not
visible.
There are some objects that are hybrids – part vector and part
raster. For example, vector text with a soft shadow. When the
colors are turned off the soft shadow is not visible. These
principles are illustrated below.
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Move to Layer
Sign Wizard Advantage, Grand, Pro - Neon Wizard all levels
Layers have been an important part of Sign Wizard since version 5
as an effective way for elements of a design to be processed
separately and later combined into an integrated design. Layering
also facilitates sending different elements of a project to routers
and other output devices for more efficient workflow.
This new feature in the Arrange menu lets you move an
object to a different layer or you can create as many new
layers as you want. (If the sidebar is not currently displayed,
click on F7. Then click on the Layers tab.) When you create a
new layer, you can assign any number or name to that layer as
long as there is not already a layer with the same number or
name. In the example below, three lines of text were created as
part of Layer 1. Each line of text, initially entered in black, was
changed to a different color and moved to a new layer whose
name was the same as the color of the text. The contents of
Layer 1 had been moved to other layers, so Layer 1 was deleted
by clicking on the Delete button at the bottom of the Layer tab.
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Color Palette Navigator
Sign Wizard and Neon Wizard – all levels
When you click on Adjustment Controls at the bottom of the
Color tab in the side bar (F7), the selected color palette with the
name of each color is displayed on the left. This feature makes
selecting colors faster and easier.
On the right is the palette’s complete spectrum. Move the slider
bar up and down to display all the colors in the palette. Clicking
on a color on the left will change any selected vector object to
that color.
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Print & Cut Registration Mark Support
Sign Wizard Pro
Sign Wizard 6.5 supports the Graphtec ARMS (Advanced
Registration Mark Sensing System) used in the FC7000 series vinyl
cutters. Sign Wizard is the only graphic design program you
need to create and print decals and other designs and cut
them with high precision.

Aries Graphics is currently developing support for other cutter
manufacturer’s registration mark sensing systems. Contact Aries
Graphics for details on the availability of drivers for those cutters.

Height and Slant Options in Soft Shadow
Sign Wizard Pro and Neon Wizard Pro
The Soft Shadow feature now includes options to adjust the height
and slant angles of the shadow.
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I m provem ents in Ex isting Features
ICC Profiles
Sign Wizard Advantage, Grand and Pro
Sign Wizard now supports ICC Profiles for importing, exporting,
printing and sending raster and vector files to a RIP.

Text Notes Enhanced with Titles and Fields
Sign Wizard Advantage, Grand, Pro - Neon Wizard all levels
The Text Notes feature now supports optional titles and fields on
the left side for creating table-like notes. You can easily reuse
previously defined fields by selecting them from a dropdown list.

Hot Keys can be used without Ctrl, Shift or Alt
Sign Wizard Grand and Pro – Neon Wizard Plus and Pro
It is no longer necessary to use Ctrl+A for customizing your
accelerator keys. You can now assign Hot Keys the letters alone without using Ctrl+, Shift+ or Alt+.
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